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SonoEQ® User Guide 

 

 

 

This document describes how to use the SonoEQ® software package to control Vega® 
ultrasound imaging systems. It includes descriptions of how to perform wide-field imaging 
scans, quantify features of interest from the 3D image data (e.g. a tumor), and export the 

results. 

 

 

 
For Technical Support or other inquiries please visit: 

http://www.revvity.com/contact-us  

 

Revvity, Inc. 
940 Winter Street 

Waltham, Massachusetts 02451 USA 
www.revvity.com 
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1 Welcome 

Vega imaging platforms are controlled by SonoEQ, the Exploration and Quantification software 
package. SonoEQ software comes preinstalled on (1) desktop computer that is provided with 
the purchase of your system, enabling both data acquisition and data analysis. This system is 
the only approved computer to control the hardware and perform data acquisition. 

Additional installation of SonoEQ on different computer workstations for data analysis is 
possible depending on the purchased software license. Please contact your Vega sales 
representative for more information. 

System Requirements: 

Computers running SonoEQ need enough processing, memory, and graphics capabilities to 
manipulate and render 3D image data, with individual file sizes equal to or exceeding hundreds 
of MB. 

• OS:  Microsoft Windows 10 or higher (64-bit) 

• Processor: Minimum of 4 CPU logical cores.  

• Graphics:  Dedicated GPU with support for OpenGL 3.2 or later (1 GB is                  
  recommended). 

• Display:   Two supported resolutions of 1920 x 1080 or 1920 x 1200. 

• Memory: Minimum RAM of 4 GB (8 GB or more is recommended). 

• Mouse: A three-button mouse with scroll wheel is recommended. 

• Other:  A PDF viewer (Adobe Acrobat Reader is recommended)  
 

 

 

Legend 

 

 

 

  

NOTE 
 

A NOTE indicates important information that helps you 
make better use of your system. 

CAUTION 
 A CAUTION indicates either potential damage to hardware 

or loss of data and tells you how to avoid the problem. 
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2 Background 

2.1 Acoustic Imaging Modes 

The instrument includes several acoustic imaging modes that vary in their function and purpose. 
Modes are selected by clicking on the respective Mode button located in the Acquisition Tab. 
The following sections give a brief background of the mode functionality and potential 
applications.  

 

2.1.1 Pulse/Echo Ultrasound (B-Mode) 

Pulse/echo ultrasound imaging is performed by sending high frequency ultrasonic pulses 
(ranging from 1 - 50 MHz) into a subject and listening for returned echoes using the same 
transducer. As ultrasound waves travel through the body, they encounter interfaces between 
tissues and get partially reflected toward the probe. The proportion of the wave that is reflected 
versus transmitted across the interface is related to the tissues’ underlying material properties 
(e.g. density, speed of sound, etc.). Images are made by recording the ultrasonic echoes and 
assigning grayscale values to their intensities, which is referred to as brightness (B)-mode.  

B-Mode imaging is highly effective at locating anatomical structures and can have very fast 
acquisition frame rates (up to or beyond 100 Hz). B-Mode is used for: 

• Identification of anatomical landmarks and organs 

• Volumetric measurements (e.g. tumor volume, kidney volume, etc.) 

• Generating a background orientation image for other advanced imaging modes 

• Real-time scout scanning for a feature of interest 

• Measuring echogenicity of an organ (e.g. fatty liver) 

2.1.2 Acoustic Angiography 

Acoustic angiography (AA) is a patented contrast-enhanced ultrasound (CEUS) imaging mode, 
which is made possible by custom dual-frequency ultrasound transducers. In AA mode, 
microbubble contrast agents are excited by a low-frequency ultrasound transducer element, like 
those used in clinical imaging (2-4 MHz), yet acoustic echoes from microbubble contrast agents 
are received with a second transducer at a much higher frequency (25-30 MHz). The excited 
microbubbles produce a broadband “super-harmonic” response, which can be detected with the 
high-frequency receiver, while tissue produces negligible echoes at these frequencies and is 
cancelled from the image. This technique yields images of blood vessel morphology entirely 
unlike standard B-Mode ultrasound images and resembling X-ray angiograms, thus leading to 
the name “acoustic angiography”. 

Acoustic angiography is used for evaluating microvasculature. Additionally, it can be used for: 

• Detecting areas of hyper/hypo-vascularization (e.g. tumors, avascular cysts) 

• Measuring blood vessel density 

• Visualizing blood vessel architecture 
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2.1.3 Shear Wave Elastography 

Shear wave elastography (SWE) is a technique used for assessing tissue stiffness by 
measuring how fast a mechanical wave travels through tissue. A long-duration and high-
intensity ultrasound pulse is delivered to “push” the tissue using acoustic radiation force and 
create a shear wave, which is tracked using successive imaging pulses. The speed of the wave 
can be measured using the time at which the generated wavefront reaches different lateral 
locations. Shear wave velocity is proportional to tissue stiffness, and if the tissue type satisfies 
several simplifying assumptions (isotropic, linear, elastic, incompressible), the speed can be 
converted into a quantitative modulus value.  

The following equations are utilized by SonoEQ to convert shear wave velocity (cs) into either 
shear (G) or Young’s (E) modulus, assuming a tissue density (ρ) equal to 1 g/cm3 and a 

Poisson’s ratio (v) equal to 0.5:  

𝐺 =  𝜌𝑐𝑠
2   

𝐸 = 2𝐺(1 + 𝑣) 

𝐸 = 3𝐺 = 3𝜌𝑐𝑠
2 

 
Shear wave elastography can be used for: 

• Assessing stiffness in tissue 
 

2.2 Ultrasound Transducers 

Vega systems can be configured with several transducers preinstalled into the robotic carriage. 
There are two main classes of transducers, “linear arrays” and “wobblers”, which can be 
selected by accessing the Settings and navigating to [Imaging Mode] → Scan Protocol. 

 

 

2.2.1 Linear Array 

A linear array transducer consists of hundreds of ultrasonic crystals arranged in a row. 
Groupings of elements are fired simultaneously to produce individual scan lines that can then be 
rapidly put together into a single 2D frame. Linear array transducers typically produce 
rectangular fields of view with uniform beam density throughout. Advantages of the linear array 
include: adjustable focal depth, multiple focal depths, angular compounding for speckle 
reduction, deeper imaging, and faster frame rates. 
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Linear arrays are useful for imaging: 

• Orthotopic and large subcutaneous tumor sizing 

• Cardiovascular dynamics 

• Deep abdominal imaging (e.g. liver) 

2.2.2 Wobbler 

A wobbler transducer consists of a single element piston that is mechanically “wobbled” to 
generate a 2D image. The piston is typically geometrically curved to a single focal point. 
Wobbler transducers produce a trapezoidal (fan)-shaped field of view due to the divergence of 
the ultrasound beam with increasing depth and wobble angle. This allows for a wider field of 
view, but with decreased line density at depth. Wobbler imaging typically has a reduced frame 
rate compared to linear array imaging; however, it can create higher quality images at the focus 
point due to higher frequencies and isotropic aperture geometry. Additionally, wobbler 
transducers exclusively support acoustic angiography (AA) mode. 

Wobbler transducers are useful for imaging: 

• Small subcutaneous tumors 

• Shallow abdominal organs 

• Epidermal imaging 

 

2.3 Scan Dimensionality 

Data dimensionality is an important concept to keep in mind while collecting and analyzing data 
in SonoEQ. In general, imaging data can be classified by up to three spatial dimensions (axial × 
lateral × elevational) and one temporal dimension (time). For the remainder of the manual, we 
will utilize the terms “sequence” and “static” to differentiate between data captured with and 
without a temporal dimension, respectively. Specifically, a “static” dataset is one where there 
are only spatial dimensions, for example a single 2D B-Mode frame or a single 3D acoustic 
angiography volume. A “sequence” dataset, on the other hand, is one that includes a time 
dimension, such as a 2D B-Mode movie of a heart beating, where the transducer is held in one 
place and 2D images are captured with a real-time frame rate. Be aware that not all imaging 
modes or transducers support all dimensionality in both “static” and “sequence” capture types. 
Scan dimensionality is chosen by clicking the appropriate section in the Acquisition Tab. 
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2.3.1 M-Mode (1D) Scan 

The motion (M)-Mode tab is primarily used for capturing 1D “sequence” datasets. An M-Mode is 
typically represented as a 2D image, where the vertical axis is the axial spatial dimension, and 
the horizontal axis is the time dimension.  

 

2.3.2 2D-scan 

The 2D scan tab is used for capturing “static” 2D images and 2D “sequences”. In these images, 
the vertical axis is the axial dimension, and the horizontal axis is the lateral (azimuth) axis. This 
scan type is the typical view offered by conventional ultrasound scanners. 

 

2.3.3 3D-scan 

The 3D scan tab is used for capturing “static” 3D volumes and 3D “sequences” (also referred to 
as 4D-Mode). 3D datasets are reconstructed by stitching together many 2D frames into a single 
volume. In the case of a 3D-sequence, 2D sequences are captured in a stepwise fashion, and 
you can optionally apply Retrospective Phase Gating to align the phases of the 2D movies 
into one cohesive 3D volume sequence. More detail about phase gating can be found in: 

D. Chittajallu et al., “Image-based methods for phase estimation, gating and temporal super-
resolution of cardiac ultrasound,” IEEE Trans. Biomed. Eng., vol. 66, no. 1, pp. 72–79, 2018. 
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3 Getting Started 

3.1 Starting the SonoEQ Software 

With the system powered on, and an animal properly sedated and placed on the imaging pad, 
you are ready to collect data. 

1) To start the SonoEQ software, double click the  icon on the desktop. 

 

2) You should see the SonoEQ Splash Screen appear to indicate the startup progress. 
 
 

   

 
Upon loading the splash screen will disappear and the main SonoEQ window will appear.  

 
NOTE:  

SonoEQ.exe is installed by default under the parent folder “C:\Program 
Files\Revvity\SonoEQ 2.0.2” and a shortcut is placed on the desktop.  

If the desktop icon has been removed, click the Windows Start menu , or 

Windows key on keyboard, type “SonoEQ”, and click the  SonoEQ icon.  
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The SonoEQ software is composed of two main graphical components: 

• Control Panel 
o This is where options and settings are set, 3D scans are deployed, etc. 

• Slice Views 
o This is where image data can be viewed. 

 

From within the control panel, the two main modes of software operation can be selected. By 
default, SonoEQ launches into Analysis mode. 

• Acquisition mode:  Collect new imaging data 

• Analysis mode:  Quantify existing data (e.g. determine tumor volume) 
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3.2 Initializing the Hardware 

When entering Acquisition mode for the first time from a powered down state, the instrument 
must be initialized. The initialization procedure involves connecting to each hardware subsystem 
(ultrasound engine, robotic motion controller, etc.) and running short calibration procedures for 
motorized components. Initialization moves all motor driven components through their full range 
of motion to establish home position and resets electronics and controllers.  

For further details on instrument operation, see the Vega Hardware Manual provided with your 
device. 

 
1) Click the Image Acquisition tab to enter Acquisition Mode.  

 
 

 
2) A progress dialog will appear and the software will connect to each of the system 

components and initialize the motion stages to the home position (if necessary). Homing 
initialization takes approximately 1 min to complete.  
 

 

 

 
 

3) Upon completion of initialization, the software will enter B-mode by default, and you will see 
both the camera and the ultrasound images streaming in real time within the Slice Views 
window. The camera stream displays the surface of the imaging platform, and the 
ultrasound stream is the 2D data coming from the ultrasound transducer’s current position. 

 
NOTE:  

Each time the computer is powered down, the software must re-home the 
motion stages. It is recommended to leave the computer power ON for the 
duration of an imaging timepoint to avoid multiple initialization operations. 



 

SonoEQ Version: 2.0.2 Revision:  22 

Title: SonoEQ User Guide 

Proprietary & Confidential   Effective Date:  11/22/2023 Page 12 of 108 

 

Copyright © 2023 Revvity, Inc. 

 

 

 

3.3 Checking the Temperature of the Heated Imaging Bays 

Vega devices with heated imaging bays will have an indicator in the lower right corner of the 
“Image Acquisition” screen. This indicator informs you about the current state of your heated 
imaging bays. When the Vega is powered ON, the heater will start to warm the animal bays. 
Average heat-up time from room temperature (21°C) to body temperature (38°C) is ~20 min. 

Icon State Description 

 

NOT READY Imaging bays are not at the desired 
temperature.  

 

READY Imaging bays are at the desired 
temperature. 

 

OFF Imaging bays are off and not 
heating. 

 

 Heated imaging bays can be turned ON and OFF using the Instrument menu.  

 
NOTE:  

The ultrasound stream can be paused/frozen using the Freeze Probe 
button located in the bottom-left of the Control Panel. Freezing the probe 
ceases all sound transmission from the currently active probe.  
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Heat Imaging Bays ON                                      Heat Imaging Bays OFF 

Upon closing acquisition, you will be prompted to choose whether you would like to keep 
heating the imaging bays. It is recommended you keep the imaging bays heated if you plan to 
continue imaging within a short period of time to avoid unnecessary heat-up time.  

3.4 Setting Study Information 

Study information is entered in the textboxes located in the left Control Panel. Data is saved to 
the Windows File System using the directory path specified in the corresponding textbox. 

1) Enter a new “Study Name.” “Study Directory” can be edited using the  button. 

 

2) If desired, enter a new “Timepoint” name. By default, this is set to the current date. 
 

 
 

 
3) Enter the ID’s of up to three animals in the “Animal ID” textboxes. These might correspond 

to the animal’s unique animal identification scheme used by your lab, such as 
“Cage202_Animal2”.  
 
 

 
 
 

 
NOTE:  

Study names and timepoints are used to index your data acquired on 
specific days, or of specific mice over time. For instance, a Study Name 
might be “ChemotherapyResponseOverTime”, and Timepoint name 
might be “Day5AfterTumorImplants” 
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4) (Optional) Click the Animal Details  button to add additional information about the study. 
The data entered into the table will be saved as a header in each image file, thereby serving 

as a permanent record of study parameters. Use the  button to propagate fields across 

animal columns (for example, if all three animals are the same Strain).  
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4 Acquiring Image Data 

4.1 Acquiring Acoustic Image Data 

The following section describes the process for capturing acoustic (i.e. ultrasound) image data 
with SonoEQ. The most common use-case is presented first – capturing a 3D static B-mode 
volume – followed by subsections that describe how to acquire data for each mode and 
dimensionality type.  

As described above, nearly all imaging modes can be set to capture single “static” image, or 
multi-frame movie “sequences”. For more background on static and sequence captures, the 
reader is referred to section 2.3. 

 

 

 
NOTE:  

For all Image Acquisitions, a thumbnail image of the scan region is 
automatically saved along with the scan data. 
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4.1.1 Acquiring a 3D B-mode/AA Volume 

1) After an animal ID has been entered, the corresponding column in the Scan Plan Table will 
become active, and a rectangular region of interest (ROI) will appear in the Live Camera 
Stream. Clicking the eyeball button toggles the visibility of the scan planning object. If the 
scan planning object is hidden, that bay will not be scanned during acquisition. 

 

 
NOTE:  

The scan plan table offers useful information about the size of the scan region 
(W x L) as well as the estimated time required for each scan to be completed. 
Larger scan regions will increase the total duration of the data acquisition.  

 
2) Select the region to scan in the camera view using the rectangular scan planning objects. 

Clicking and dragging on the green handle in the center re-positions the entire scan region, 
while clicking/dragging the red and blue handles adjusts the bounds. 

 

 
NOTE:  

The location of the ultrasound probe is indicated on the camera view 
and can be manipulated with the motion control pad for a quick 
glance into the animal.   

 
3) Once you are satisfied with the scan region placement, click Acquire Static to begin the 

acquisition.  
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4) Once the data is captured and processing is finished, clicking the Load  button under the 
Animal ID textbox will load the scan for previewing (see section 4.2). 
 

 

4.1.2 Acquiring a 2D B-mode Image 

 

1) To collect 2D scans, navigate to the 2D Scan tab in the Control Panel.  
 

2) The transducer can be moved to the desired location using the directional arrows in the 
motion control pad. The circular Go-To-Position button in the center allows you to send the 
transducer to a selected location by clicking the button and then clicking on the slice viewers 
(webcam or ultrasound live stream, or on a loaded volume). 

 
3) A 2D static image or sequence can be acquired using either the Acquire Static or Acquire 

Sequence button, respectively. 2D sequences can be captured to assess cardiac function 
using the same protocol as acquiring an M-Mode, and the “2D Scan” tab also includes the 
Heart Finder row to acquire heart location images. 

 

4) Once the data is captured and processing is finished, clicking the Load  button under the 
Animal ID textbox will load the scan for previewing (see section 4.2). 

 
NOTE:  

Retrospective cardiac phase gating can be enabled for 2D sequences (see 
section 4.3.2). 
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4.1.3 Acquiring a 1D M-Mode Sequence 

M-Mode imaging produces high frame rate sequences to characterize 

moving anatomy, such as left ventricular motion of the heart. The image 

that is displayed represents one line of the B-Mode image plotted over time.  

 

 

 

Animal Positioning: For optimal M-Mode cardiac images, the animal should 

be in the prone position and be angled by approximately 30 degrees to the 

right of vertical to obtain a short axis view of the heart. 

 

 

 
1) To acquire M-Mode data, click the tab labeled M-Mode in the Acquisition panel. The 

software will switch into a 3-slice view showing real-time streams of both B-Mode and M-

Mode. The position of the single M-Mode line is indicated by a green vertical line shown in 

the B-Mode stream. 

 

 

2) (Optional) If desired, you can run the Heart Finder algorithm to automatically find the heart in 

3D space. This feature is useful to consistently place the M-Mode interrogation line in the 

appropriate position when quantifying cardiac parameters such as Ejection Fraction (EF). To 

 
NOTE:  M-Mode images can only be acquired with a linear array transducer. 
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enable the Heart Finder workflow, first click the Place ROI button located in the table. An 

ROI will appear (like those shown in 3D Image mode). The button text will change to Find 

Heart, and upon another click, the region of interest will be scanned, and a heart location 

image will appear. 

 

 

  

 

3) (Optional) After the heart has been localized, click the center button of the motion control 

pad, and then click the location on the Heart Location image you wish the transducer to 

move to. 

 

 

4) Once you are satisfied with the scan region placement, click Acquire Sequence to begin 

the M-Mode acquisition. Sequence duration can be set in the Settings menu (see section 

4.3.1) and is set to a default of 2 sec. The corresponding B-Mode is also saved. 

 

 

 

5) Once the data is captured and processing is finished, clicking the Load  button under the 
Animal ID textbox will load the scan for previewing (see section 4.2). 

 

4.1.4 Acquiring a 3D B-mode Sequence 

The only application currently supported for 3D sequences is for cardiac imaging, and the linear 
array is the only supported transducer. Data from a 3D sequence will automatically be 



 

SonoEQ Version: 2.0.2 Revision:  22 

Title: SonoEQ User Guide 

Proprietary & Confidential   Effective Date:  11/22/2023 Page 20 of 108 

 

Copyright © 2023 Revvity, Inc. 

 

processed as a cardiac data set and will result in a 3D sequence of a heart beating over a single 
cycle. 

1) In the 3D tab, the Place ROI button in the Heart Finder row is automatically set to Find 
Heart. Clicking the button will run a scan to produce the heart location image using the 
existing ROI.  Previous heart finder scans, like those collected for M-Mode acquisitions, can 

be loaded through the Load  button menu and used for positioning of acquisition ROI 
(discussed further in section 4.2). 

 

 

 
2) Change the ROI width to a single pass (12.8 mm) and a length of about 10 mm. Move the 

ROI to be centered around the bottom of the heart location image, ensuring the ROI 
includes the apex of the heart. 

 

3) Select the desired Sequence Duration (see section 4.3.1). The phase correction algorithm 

is optimized for a duration of 2 seconds.  

 

 
4) Click Acquire Sequence to start the scan. 

 
NOTE:  A longer duration may increase the processing time of phase correction. 
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5) Once the data is captured and processing is finished, clicking the Load  button under the 
Animal ID textbox will load the scan for previewing (see section 4.2). 

 

4.1.5 Acquiring a 2D SWE Image 

The shear wave elastography (SWE) mode consists of a 2D B-Mode stream, where a smaller 
region must be defined for capturing a stiffness image. In SWE mode, only 2D and 3D images 
can be acquired so the M-Mode tab will be disabled. To collect 2D SWE images, navigate to the 
2D Scan tab in the Control Panel. 

1) The transducer can be moved with the motion control pad (orange box) to center the green 
analysis window (white arrow) on the tissue of interest.  

 

       
 
 

2) The axial and lateral bounds of the analysis window can then be adjusted to further focus on 
a region by dragging the green or red interaction handles on the analysis window box. The 
green analysis box cannot extend beyond the blue box, so if the desired imaging target lies 
outside of the blue box the transducer needs to be moved or the animal repositioned. 

 
3) Click the Acquire Static button to capture a 2D SWE volume as well as a reference B-

Mode. 
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4) Once the data is captured and processing is finished, clicking the Load  button under the 
Animal ID textbox will load the scan for previewing (see section 4.2). 
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4.1.6 Acquiring a 3D SWE Volume 

The workflow for acquiring a 3D SWE volume is just like acquiring a 3D B-Mode volume, with 
the addition of adjusting the SWE analysis window. At this time, 3D SWE acquisition can only 
be acquired as a Stepped Scan due to the limited frame rate of the SWE mode (for more details 
on Step Mode settings see section 4.3.1). 

 

1) A scan region can be selecting by moving and resizing the ROI on the coronal (green) slice 
either on the live camera view or a loaded volume. 
 

2) The axial bounds of the analysis window can then be adjusted to further focus on a region by 
dragging the green or red interaction handles on the analysis window box.  

 
3) Click the Acquire Static button to capture a 3D SWE volume as well as a reference 3D B-

Mode. 
 

4) Data can be loaded into the scene for preview by clicking the Load  button under the 
Animal ID textbox (see section 4.2). 

 

 
NOTE:  

The green analysis region on the ultrasound live stream cannot be made 
wider than the blue box, but the lateral extent of the scan is determined by the 
ROI on the coronal (green) slice, and not the width of the blue box. 
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4.2 Previewing Acquired Data 

1) After clicking Acquire Static or Acquire Sequence for the different imaging modes and 
dimensionalities, a progress bar will indicate how long until the scan is complete, and 
various icons will appear under the Animal ID textboxes to indicate when a volume has been 
reconstructed and is ready for loading/viewing. 
 

 

Empty cell indicates no data has been captured for that 

animal yet. 

 

Wheel icon indicates waiting actions such as when raw 
volume data is currently being reconstructed or 
acquisitions are being loaded into the scene. 

 

Load icon indicates that volumes have been reconstructed 
successfully, saved to disk, and can be loaded in to 
preview. 

 

2) Once all scanning is complete, you can either click on the Load  button under the Animal 

ID textbox to bring up the Analysis view, or the Next  button to clear the animals’ info and 
begin scanning the next set of animals. 

 
NOTE:  

Clicking the Next button will clear *ALL* animal IDs from the textboxes and 
remove loaded volumes from the scene. To clear individual animals, use the 
drop-down arrow as shown below. Note that clicking the Next button does not 
delete data, it simply clears the textboxes. 

 
3) The arrow on the side of Load button is a menu that contains all previously acquired 

datasets for that study name/timepoint/animal ID combination. 
 

 

 

 
NOTE:  

Default save location: %User Profile%\Documents\SonoEQ\Study_Name 
\Timepoint\Animal_ID\B-Mode_3D Scan_YYYY_MM_DD_HH_MM_SS\ 
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4.3 Acquisition Settings/Presets 

Imaging settings can be adjusted to improve image quality for different applications and obtain 
various kinds of images. Acquisition Settings are divided into Scan Protocol and Post-Scan 
settings for each imaging mode. Furthermore, each imaging mode has factory-defined presets 
that update multiple settings in the Scan Protocol and Post-Scan panels. Specific settings can 
still be customized, but clicking a scan preset button will return specified settings to their preset 
defined values.  

To access the settings, either click on the Settings Tray (>>) button that appears next to 
Control Panel, press Ctrl + “2”, or click on Edit → Settings.  

4.3.1 Scan Protocol Settings 

Settings in the Scan Protocol panel control all aspects of the image acquisition and are grouped 
into Transducer settings and Scan-Protocol settings. 

Transducer settings – This group of settings control the performance of the ultrasound 
transducers.  

 

• Imaging Depth – Total range/extent of imaging window. 

• Time-Gain Compensation (TGC) – Gain that can be changed to change image brightness. 
The overall brightness can be updated using the Overall TGC slider which will adjust the 
individual areas accordingly. 
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• Individual TGC – Sliders to adjust the image brightness as different depths to 
account for signal attenuation. 

• Apply Default TGC – Reverts the TGC sliders to the factory settings. 

• Focal Depth – Depth at which ultrasound is focused and the image is the sharpest. 

• Multi-Focal Zone – Up to four focal zones can be activated at once for improved 
image quality through depth. Each additional focal zone that is added will reduce 
the imaging frame rate by the corresponding number of zones. E.g. if the frame 
rate with 1 focal zone is 100 Hz, 2 focal zones will reduce to 50 Hz, 3 focal zones 
to 33 Hz, etc.  

• Transmit Frequency – Frequency of output ultrasound pulses in units of MHz. Higher 
frequencies have better resolution, but worse depth of penetration. 

• Frame Rate – Rate at which 2D images are acquired. 

• Frozen entering imaging mode – When checked, the probe will be frozen when the 
specified Mode is entered. E.g. if the acquisition is in B-Mode and switches to AA-Mode, if 
checked, the probe will automatically freeze prior to switching into AA. This setting can 
prevent unintentional transmission of low frequency sound waves when toggling modes. 

• Wobbler only: 

• Frame Acquisition – Number of directions over which to acquire data on the 
wobble path. Frame rate is halved when using “unidirectional” mode. 

• Jitter Compensation – Value to compensate for any misalignment between 
images taken from each direction of the wobble (see “bidirectional” mode). 

• Linear Array only: 

• Spatial Compounding – Averaging of frames to reduce speckle. Sound waves 
for frames are “steered” and combined to provide images from different angles. 

• SC Count – Number of frames to be averaged. 

• SC Angle Delta – difference between the steering angles for each frame. 

• Collect RF Data - Collect raw radiofrequency ultrasound data.  

Shear Wave Elastography Transducer Settings – This group of settings controls the linear 
array settings for shear wave elastography acquisitions. 
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• Push Offset – offset between the lateral location of the push pulse and tracking region. 

o The push pulse can be transmitted to the right or left of the tracking region. 

Acoustic Scan-Plan Settings – This group of settings affects 3D ultrasound acquisitions and 

sets the shape/timing of the acquisition. 

  

• Frame Spacing – Distance between frames (i.e. out-of-plane spacing). 

• Scan Speed – Speed at which transducers move. This setting cannot be controlled by 
the user. 

• Default ROI Width/Length – Default width and length of 3D ROIs that can be selected 
using the Default button in the acquisition table in 3D tab. Imaging mode specific. 

• Remember ROI Size and Position – When checked, the ROI size and position for a 
given imaging mode will be remembered after switching modes. 

• Step Mode – 

• Stepped – Acquire one or more frames per position. The transducer comes to a 
complete stop with each step before advancing to the next position. 

• Frames Per Position - number of frames to acquire at each step. When 
used for a static acquisition, multiple frames in the same spatial location 
will be averaged together during volume fusing (which can improve image 
signal-to-noise ratio).  

• Continuous – Acquire a single frame per position. Transducer sweeps across 
each pass without stopping. 
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• Sequence Duration – Duration of M-Mode and 2D sequences. Also represents the 
duration of sequence at each step in a 3D sequence scan. 

• Advanced Timing Settings – 

• Δt between stepped positions – Delay between steps when Step Mode is set 
to “Stepped”. 

• Δt between start of passes – Delay between the start of each pass for a multi-
pass scan. 

• Repetitions – Number of times to repeat a scan. Data from multiple repetitions is 
averaged together. 

• Δt between start of repetitions – Delay between the start of each repetition for 
a multi-repetition scan. 

 

4.3.2 Post-Scan Settings 

Ultrasound Post-Scan Settings 

Post-Scan settings control actions that can happen after data acquisition, such as Fusing, which 
is the process of stitching multiple passes into a single 3D volume. 

 

• Processing Options – 

• Process Now – Process (3D reconstruction, Phase Gating, SWE processing) 
scan immediately after acquisition. 

• Process Later – Delay processing for a later time. You will be prompted to 
process any unprocessed volume when exiting SonoEQ. Furthermore, you can 
process volumes manually by using the tools menu (Tools → Volume 
Reconstructor, Run Phase Gating, Run SWE Processing). 

• Auto-generate MIP – write a .PNG file containing a maximum intensity projection (MIP) 
of the acquired 3D scan 

• Threshold for Breathing Motion – 3D B-Mode and AA scans can be processed to 
remove breathing artifacts after acquisition. The threshold for the algorithm (Low, 
Medium, High) defines how aggressively to remove artifacts with “High” being the most 
aggressive, which might result in removing data without breath artifacts. 

• Unprocessed Data Storage –  
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• Uncompressed – Write the unfused and unprocessed data taken with each 
acquisition without compression. 

• Compressed – Write the unfused and unprocessed data taken with each 
acquisition with compression to reduce file size. 

• Remove after processing – Remove the unfused and unprocessed data after 
the initial fusing and processing for that data is complete. 

• Fused Volume Z Spacing – Distance between frames in reconstructed 3D scan. 

• Same as acquired – value specified by Frame Spacing in Scan-Plan settings. 

• Custom – use a different value than that specified by Frame Spacing setting. If 
the reconstruction spacing is set larger than the acquired frame spacing, 
overlapping frames will be averaged. If the reconstruction spacing is set smaller 
than the acquired frame spacing, there may be “holes” in the reconstructed 
image, i.e. black areas where no real data exists to fill the voxel. 

• 2D Phase Correction – enabling this setting processes an acquired sequence to 
produce a single-cycle cardiac sequence. For more details, see section 2.3.3. 

 

 
NOTE:  3D sequences are automatically processed with phase correction. 
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4.3.3 B-Mode Presets 

 

Optimized – Acquire maximum quality images at the cost of longer scan times. 

• Suitable for breathing correction 

• 0.1 mm spacing (Linear Array), 0.13 mm spacing (Dual Element Wobbler) 

• Slower scan speed 

Multi-focal Optimized – Acquire images with maximum quality throughout depth. 

• 3 focal zones 

• Slower scan speed 

Fast Scan – Quickly acquire medium quality images. 

• No breathing correction 

• 0.15 mm spacing (Linear Array), 0.25 mm spacing (Dual Element Wobbler) 

• Faster scan speed 
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4.3.4 Acoustic Angiography Presets 

 

Density – The settings for this preset allow for the capture of all vascular information 
including resolvable and sub-resolution vasculature. 

• Continuous scan 

• Multiple repetitions 

• Fast scan speed 

Morphology – This preset is designed to isolate signal from resolvable vessels (≥100 
µm) for visualization of vascular architecture. 

• Stepped scan 

• Multiple images per spatial location 

• Slow scan speed 
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4.3.5 Shear Wave Elastography Presets 

 

Optimized – Best parameters for acquiring a high-quality SWE image.  
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4.3.6 Custom User Presets 

 

Changes to scan settings can be saved into custom presets per imaging mode. Clicking the 
Save Preset As button brings up a dialog where you can name your preset and save it to disk.  

To edit a user-defined preset, click the arrow on the side of the custom preset button to access 
its context menu. From here you can rename, delete, or overwrite the preset with the current 
scan settings. 

 

While the factory presets do not set all imaging settings, custom presets save all the Scan 
Protocol and Post-Scan settings for that mode. Furthermore, a Shear Wave Elastography 
custom preset saves setting for both Shear Wave Elastography and B-Mode imaging modes. 
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5 Analyzing Image Data 

The following sections describe different ways of analyzing data. In general, analyzing data 
involves annotating the data (i.e. “segmenting”) to extract parameters of interest (e.g., volume 
measurement, image intensity, functional metrics, etc.). Datasets with different dimensionality 
usually require unique tools to perform measurements. These are described in more detail 
below. 

SonoEQ starts in Analysis mode by default, and can be accessed by clicking the Image 
Analysis Tab. 

  

5.1 Loading Image Data 

Data can be loaded into SonoEQ using the Load Dialog by clicking the Load Volume(s) button. 

 

 
NOTE:  

The default save location for all data captured with SonoEQ is: 
%UserProfile%\Documents\SonoEQ 

 

The Load Dialog can be populated by adding volumes using the Select Folder and Select 
File(s) buttons. 

Select Folder – will open a Windows file explorer window where you can point to the 
location of a data folder. All available scans on that folder and its subfolders will be 
added to the Load Dialog. 

Select File(s) – will open a Windows file explorer window where you can point to a 
single scan file (MHA, SEQ.MHD, SEW.NRRD). Only that file and any accompanying 
files, such as the supporting 2D B-Mode acquired during a 2D SWE acquisition, are 
added to the Load Dialog. 

Select Folder and Select File(s) can be used multiple times to populate the Load Dialog. 
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Clicking OK will only load the files that are visible and checked in the table. Further tuning can 
be done by using the Filter text box and checking/unchecking entries in the table. In this 
example, only the “animal1” 2D entries that are checked will be loaded. 

  

Furthermore, data can be quickly loaded by Drag-and-Dropping a file or folder into SonoEQ. 
Drag-and-dropping a folder will load all available image files in the folder and drag-and-dropping 
a file will load that file, and any supporting multi-stream images (e.g. B-mode 2Dt from an M-
Mode acquisition). 
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5.1.1 Loading Multi-Modal Data 

SonoEQ supports the loading of data acquired with other Revvity In Vivo imaging devices. 
Loading data from other devices follows the same workflow outlined in Section 5.1. 

The following data acquired with the IVIS® Lumina or Spectrum imaging systems and exported 
with the Living Image® Analysis Software can be viewed in SonoEQ image analysis. 

 File Type Extension 

 Luminescent (2D/3D) .tiff 

 CT (3D) .dcm 

 Photograph (2D) .png 

 

 

Sequences of Luminescent Photographs (2D) can be viewed using the Playback widget located 
in the toolbar. Playing the sequence is controlled via the Play/Pause button. Advancing the 
movie forward or backward can be done by clicking the Backward/Forward buttons. The 
current frame of the movie can be manipulated by adjusting the Playback Slider. 
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The following data acquired with the Quantum GX2 imaging system can be viewed and 
segmented in SonoEQ image analysis. 

 File Type Extension 

 CT (3D) .vox 
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NOTE:  

Data acquired with the IVIS® systems must be exported as float-corrected 
images and be accompanied by a SequenceInfo.txt or ClickInfo.txt file to 
load. See Living Image User Manual for more details on export features. 

5.1.2 Viewing Multi-Modal Data Side-By-Side 

Data acquired with the Vega can be visualized side-by-side with data acquired with other 
Revvity In-Vivo imaging devices in SonoEQ. This feature allows for multimodal data comparison 
of the same mouse. 

  

Vega Ultrasound Data (top) and QuantumGX2 Data (bottom) 

To view data from different imaging modalities, first ensure that your two volumes are the 
selected primary and secondary volumes, then choose the Side-By-Side or Three over three 
views from the Slice View settings in the toolbar.  
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To select a non-default slice orientation, hover over the  icon and select the orientation you 
wish to appear in the slice. 
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5.2 Viewing/Navigating Image Data 

A 3D B-Mode will be used to illustrate how data is displayed and oriented. Upon loading a 3D 

data set, the Slice Views window in SonoEQ will display a 2x2 grid of windows. This “Four-Up” 

view shows the three 2D orthogonal views - axial (red), coronal (green), and sagittal (yellow) - 

along with all three slices simultaneously displayed in the 3D view (blue). 

 
 

These three orthogonal planes correspond to the Vega imaging system as follows: 

 

 
NOTE:  The ultrasound beam is always coplanar to the Red/Axial plane. 
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Prior to segmenting the image, it is helpful to quickly scroll through the image slices and orient 

yourself to common anatomical landmarks. Scrolling can be done by hovering the mouse over a 

given slice and using the mouse wheel, or by clicking and dragging the slider above each slice 

as indicated below. Additionally, the image can be zoomed by right-clicking and dragging up or 

down or panned by clicking and dragging the mouse-wheel button. See Chapter 10 for 

additional tips. 

 

 

5.3 Overlaying Multiple Datasets 

Vega instruments offer the capability of capturing multi-modal datasets from the same subject 
(e.g. B-Mode and Acoustic Angiography). These images can be analyzed separately or, if 
desired, analyzed together by overlaying the captured data. This is accomplished through the 
Primary and Secondary selector drop down menus. 

 

1) Select two files in the Load File Dialog that represent images captured from the same 
mouse and same timepoint. 

  

 
NOTE:  

If the file chosen represents a two-stream dataset (e.g. B-Mode + M-Mode), 
both datasets will be pulled into the Load File Dialog automatically.  
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2) Select each volume to the Primary and Secondary menus, respectively. Typically, the B-
Mode (used for anatomical context) is used as the Primary volume while the advanced 
imaging mode (e.g. Acoustic Angiography) is used as the Secondary volume. 

 

3) By default, the two volumes will be rendered in Overlay Mode, with the Secondary volume 
blended with the Primary volume. Adjust the Opacity Slider to set to the opacity of the 
layers to accentuate either the primary or secondary volume as desired. Below shows an 
example of Acoustic Angiography image (yellow pixels) overlaid with 50% opacity on top of 
a B-Mode (gray pixels) positioned over the mouse kidneys. 

 
 
 

 CAUTION:  

When overlaying two volumes, an assumption is made that the animal did 
not move between scans. If properly sedated, animals should remain in 
the same position to allow overlaying consecutively acquired data sets. 
However, if the mouse changes position during imaging (e.g. wakes from 
anesthesia), the image data will be misaligned in the overlay view. 

 
 
 

4) Alternatively, Primary and Secondary volumes can be viewed in Side-By-Side Mode by 

clicking the View Toggle button next to the Primary volume selector . When viewing 
volumes in side-by-side, the Slice View for the Secondary volume will be color coded with a 
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faded color palette and is referred to as the “+” layout (e.g. Red and Red+). Clicking the 

View Toggle button a second time will return to Overlay View .  

 
 
 

 
NOTE:  

Depending on the acquisition parameters, the Primary and Secondary 
volumes may not span the same spatial extent. For example, a B-Mode may 
be taken as a widefield scout scan of the whole abdomen, but Acoustic 
Angiography may be targeted to the kidneys specifically. If this is the case, 
the Slice views will limit the visible extent to the bounds of the Primary 
volume. To quickly toggle the positions of the Primary and Secondary 
volumes (and thereby change the maximum visible extent), the Switch button 

can be utilized .  

 
 
A pair of 3D static volumes that have overlapping spatial extents support the option to link 
slice intersections between both volumes. Linking/unlinking slice intersections for a pair of 
3D static volumes can be controlled through the link button in the slice controller (visible 
when mouse hovering over the slice header). 
 

 
 

This links the slice offsets of both volume such that adjusting one will adjust the 
corresponding offset in the other volume (red slice offset in primary volume will change the 
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offset in the red slice in the secondary volume), which allows for easily viewing the same 
world location across two datasets such as a B-Mode and Acoustic Angiography volume.  
 

 
 

 
NOTE:  

Holding shift and moving the mouse cursor over one of the slice viewers will 
center the other slices on that location. If the volumes are linked, the slices for 
both volumes are centered on the mouse cursor location. 

 

  



 

SonoEQ Version: 2.0.2 Revision:  22 

Title: SonoEQ User Guide 

Proprietary & Confidential   Effective Date:  11/22/2023 Page 45 of 108 

 

Copyright © 2023 Revvity, Inc. 

 

5.4 Creating Segmentations and Quantifying Data 

To quantify various aspects of image data, a “segmentation” must be created. The process of 
segmenting (also known as contouring) involves delineating structures of interest in 3D space. 
Due to the wide breadth of applications that are supported by the Revvity instruments, SonoEQ 
includes a variety of segmentation tools, also known as “segmentation effects”, that can be 
utilized. The most basic effects mimic a manual painting interface (akin to Adobe Photoshop) 
but work on 3D matrices of voxels rather than on 2D pixels. Other, more sophisticated effects 
automate the segmentation process by making assumptions about the geometry of the 3D 
object that is being painted or utilizing information from the volume itself to simplify the process. 

The subsections below are organized such that segmentation effects are introduced first, 
followed by step-by-step tutorials on how to apply each based on the given datatype and 
dimensionality (starting with the basic static 3D volume). Note that not all effects are applicable 
to all datatypes, and SonoEQ will limit the available effects as necessary (e.g. M-mode 
sequences have different segmentation effects than 3D volumes). 

5.4.1 Segmentation Effects Overview 

The following segmentation effects are available in SonoEQ. From left to right, they are None, 
Surface Cut, Draw, Scissors, Paint, Erase, Fill Between Slices, and Smoothing: 

 
Segmentation effects toolbar  

 

• None – Deselects the segment effect. Use this option when manipulating the segmentation 
is not desired (e.g. panning through the data, zooming, 3D render, etc.). 

 

• Surface Cut – Uses control points to fill a segment following a convex hull-like algorithm. 
This effect can be used for quickly segmenting simple spheroidal 3D shapes with little or no 
concavities, such as a tumor. 
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• Point Placement Button – Toggles the cursor into point placement mode for 
placing control points. This button must be un-selected to move already placed 
control points. Right-clicking in a slice view will un-select this button. 

• Delete Point Button – Deletes the most recently placed control point. Click the 
dropdown button to show a menu that allows deleting all points in one action. 

• Edit – Used to re-enter the “Editable” mode of a surface cut segmentation. This 
button is utilized when a surface cut needs to be modified after clicking the Apply 
button. 

• Operations – 

• Replace (default) – replaces the old 3D segmentation with the new one. 

• Fill inside – adds additional area to the old segmentation. 

• Erase inside – deletes overlapping area. 

• Smooth Model – smooths the resulting segmentation and removes sharp 
corners. Turning this option OFF will produce a true convex-hull segmentation. 

 

• Draw – Creates a segment in a single 2D slice. 

 

 

  
 

• Left click – Adds successive points to the drawing region. 

• Left click and drag – Draws a continuous curve (similar to a lasso tool.) 

• X key – Delete the last added point. 

• Right click or Enter – Completes the segmentation and fills the lassoed space. 
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• Scissors – Cut through slices from a single 2D slice. 

 

 

 

 

• Left click and drag – Depending on selected operation, draw a continuous 
curve to cut (similar to a lasso tool) or draw a shape. 

• Esc – Cancel an unfished cut. 

• Operation – 

• Fill inside (default) – adds additional area within the lasso. 

• Fill outside – adds additional area outside of the lasso. 

• Erase inside – deletes overlapping area within the lasso. 

• Erase outside – deletes overlapping area outside of the lasso. 

• Slice Cut – 

• Unlimited – Project the cut through the entire volume 

• Positive – Only positive side of the slice plane is included in cut region 

• Negative – Only negative side of the slice plane is included in cut region 

• Symmetric – Cut region is limited to specified thickness around the slice 
plane 
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• Paint – Paints with a circular brush in either 2D or 3D.  

 

 

 
 

• Left click – Paints a single circular region. 

• Left click and drag – Paint in a continuous manner. 

• Shift + mouse wheel or +/- keys – adjust the brush size. 

• Ctrl + mouse wheel – Zoom the slice view in/out. 

• Diameter – Sets the size of the circular brush region. 

• Sphere Brush – Toggles between a 2D and 3D brush. Note that if Sphere Brush 
is active, segmentation voxels will be filled out of plane and will not be visible in 
the current slice view until the viewer is scrolled. 

• Edit in 3D Views – Allow painting in 3D view. If enabled, click-and-drag in the 3D 
view paints in the view instead of rotating the view. 

• Color smudge – Select segment by sampling the pixel location where the brush 
stroke starts. If brush stroke starts in an empty area, then the brush erases 
highlighted region from the selected segment. 

 

• Erase – Erases with a circular brush in either 2D or 3D. 

 

 
 

• Left click – Erases a single circular region. 

• Left click and drag – Erase in a continuous manner. 

• Shift + mouse wheel or +/- keys – adjust the eraser size. 

• Ctrl + mouse wheel – Zoom the slice view in/out. 

• Diameter – Sets the size of the circular eraser region. 
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• Sphere Brush – Toggles between a 2D and 3D eraser. Note that if Sphere 
Brush is active, segmentation voxels will be erased out of plane. 

• Edit in 3D Views – Allow erasing in 3D view. If enabled, click-and-drag in the 3D 
view erases in the view instead of rotating the view. 

 

• Fill Between Slices – Interpolates segmentation between slices. This tool is used in 
conjunction with other effects (e.g. paint, draw), and will fill gaps where empty slices exist. 
The segmentation will only be expanded if a slice is segmented but none of the direct 
neighbors are segmented. 

 

 

 
 

• Preview: 

• Initialize – Initializes the Fill Between algorithm and produces a preview 
of the filled region in a transparent color in the slice views.  

• Auto-update – Toggles whether the Fill Between algorithm should be re-
initialized automatically upon modifying the segmentation (e.g. painting a 
new slice). If enabled, the preview will adjust each time a new slice is 
added. 

• Display:  

• Inputs – Adjusts the transparency of the input segmentation to be more 
or less visible based on the position of the slider. 

• Show 3D – Toggles whether the segmentation is visible in the 3D view. 
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• Smoothing – Makes segment boundaries smoother by removing extrusions and filling 
small holes. This effect is applied AFTER an initial segmentation has been drawn using the 
other effects. 

 

 

 
 

• Gaussian 

• Standard Deviation – Sets the standard deviation value (σ) of the 
Gaussian smoothing kernel. 

• Median 

• Kernel Size – Sets the size of the median filter kernel. 

• Opening 

• Kernel Size – Extrusions smaller than this size will be removed. 

• Closing 

• Kernel Size – Sharp corners and holes smaller than this size will be filled. 

• Diameter – Sets the size of the circular eraser region. 

• Sphere Brush – Toggles between a 2D and 3D eraser. Note that if Sphere 
Brush is active, segmentation voxels will be erased out of plane. 

• Edit in 3D Views – Allow erasing in 3D view. If enabled, click-and-drag in the 3D 
view erases in the view instead of rotating the view. 
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The selected segmentation effect is displayed next to the cursor when hovering over slice views 
to avoid confusion. 

 

5.4.2 Creating a Segmentation with Surface Cut 

The following section gives a tutorial on how to draw a segmentation using the “Surface Cut” 
technique. This approach allows rapid segmenting of 3D shapes with very few clicks. In general, 
this method works best when features of interest have simple spherical/ellipsoidal geometries 
(e.g. tumors, kidney, bladder, etc.). As an example, a tumor is segmented below. 

1) With the feature of interest identified in all three planes, click the Add button, and a new row 
will appear in the “Segmentations” table, 

 
 

 

When the Add button in the create tab is clicked, the default segmentation effect that is selected 
is Surface Cut. Surface Cut allows points to be placed by clicking on the 3D Image slice views. 
A surface is generated which intersects as many of the placed points as possible. 

The goal of the next several steps will be to define the boundaries around the perimeter of the 
tumor such that a 3D surface (i.e. a segmentation encompassing the entire volume of the tumor) 
can be produced.  
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The figure above is a high-level overview of the approach and illustrates the workflow for 
Surface Cut. In this figure, there is no image data shown, but the intention is to extract a feature 
of interest (e.g. a kidney) and that these points fall at the interface between the tissue of 
interest, and surrounding tissue. 

 

A) The first three points (1,2, and 3) have been added to the perimeter of the structure of 
interest. The software then automatically draws a smooth contour encompassing those points.  

 

B-C) As additional points (4 and 5) are added to refine the shape of the surface, the contour will 
update in real time.  

 

D) If a point is added beyond the existing perimeter bounds, the contour will adapt to include 
that new point (6, indicated by arrow), disregarding the contribution from the nearby point (4, 
indicated by red X) because it now lies within the interior of the surface. 
 
The workflow described above is performed using SonoEQ on 3D ultrasound data, but for 
simplicity was illustrated in 2D in the above figure. The following steps will describe how to 
perform the Surface Draw procedure on actual 3D ultrasound data. 

2) The software will automatically enter Point Placement mode . You can begin clicking on 
one of the three image planes to place segment points.  

 

 
NOTE:  

Placing points in a single slice view will generate a single-slice segmentation. 
Placing points in orthogonal slice views (i.e. out-of-plane) will expand the 
segmentation from 2D to 3D. 

 

3) If you made a mistake and need to adjust a point, simply toggle the Point Placement mode 
and click-and-drag points to adjust them.  
 

4) To Delete a point placement, utilize the trash can button  to delete the most recently 
placed point. Alternatively, clicking the dropdown arrow on the trashcan button will allow you 
to Delete All Points, and start over. 
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5) Continue placing points around the tissue of interest (e.g. tumor) until the contour lines of 
the segmentation match the boundary of the object being segmented. The more points that 
are placed, the more accurate the 3D surface will be. In the following example, 7 points in 
the Axial view and 2 points in the Coronal view define the tumor region. 

 

 
 

6) After all points have been placed, click the Apply button to fill the region defined by the 
surface and generate a 3D segmentation object.  
 

 
 

7) The interpolated segmentation will then appear as a translucent overlay in the slice views 
and will be rendered in 3D as a translucent surface. Additionally, the volume of the 
segmentation will be displayed in the Segmentations table. 
 

 

 
8) After reviewing the segmentation, if you are unsatisfied with its accuracy, simply click the 

Edit button to return into the Surface Cut effect and add/modify/remove points. 
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NOTE:  

Three options determine how an edited segment will appear after clicking 
Apply: 
 

• Replace (default) – replaces the old 3D segmentation with the new 
one. 
 

• Fill inside – adds additional area to the old segmentation. 
 

• Erase – deletes overlapping area. 
 

Using the Erase option allows the generation of concave regions in a 
segmentation. 

 

5.4.3 Creating a Segmentation with Slice Painting 

The following section gives a tutorial on how to draw a segmentation using the “Slice Painting” 
technique. This approach allows more flexibility compared to the Surface Cut approach but is 
more time intensive. As an example, the liver of a mouse with NAFLD is segmented below. 

 
1) With the feature of interest (in this example, assumed to be a liver) identified in all three 

planes, click the Add button.  
 

 

 
A new row will appear in the “Segmentations” table,  
 

 
 

2) Click the Draw effect. The software will enter Point Placement mode , and you can begin 
clicking on one of the three image planes to place draw points. Clicking and dragging will 
create a continuous line that follows the mouse cursor, or alternatively individual clicks will 
connect with a straight line. 
 

3) To Delete a point placement, press the “x” key on the keyboard. 
 

4) Continue placing points around the tissue of interest (e.g. liver) until the contour lines of the 
segmentation match the boundary of the object being segmented. Once complete, either 
click the Right mouse button or press “Enter” to fill the region. 
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Original image Outlined 2D region Filled 2D region 

 

5) Advance the slice view using the mouse wheel or the slice slider and repeat the process, 
drawing sequent 2D outlines to cover the length of the feature of interest. If desired, each 
individual 2D frame came be segmented manually following this process, however this is 
typically very time consuming. Instead, it is advisable to only segment a subset of the slices 
and use the Fill Between Slices and Smoothing effects as described below. 
 

6) After drawing several 2D slices and covering the extent of the feature of interest, navigate to 
the Fill Between Slices effect and click the Initialize button. Once initialized, the 
interpolation algorithm will be run automatically filling the empty space between the regions. 
New 2D segmentations can be added as desired. Once finished, click the Apply button to 
complete the segmentation. 
 

 
 

1 slice painted 

 
 

5 slices painted 

 
 

Filled slices 

 

 
NOTE:  

Filling between slices will only interpolate and does not do any extrapolation. 
This means that one slice at the top and bottom of the feature of interest must 
be drawn, otherwise it will appear as a truncated segmentation.  
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7) (Optional) Sometimes after the slices are filled, there are sharp transitions that may be 
undesirable for visualization purposes. The 3D filled segmentation can be smoothed using 
the Smoothing effect.  

Original segmentation after fill 

 

Smoothed segmentation  3D rendering 
    

5.4.4 Quantifying a Segmentation 

To quantify the segmentations and export results to disk, click on the Quantify tab within the 

Control Panel.  

 

Measurements are broken into “Surface statistics” and “Image statistics”. Surface statistics 

represent gross parameters of the segmentation object such as volume and surface area.  

 

Image statistics apply the segmentation as a mask to the underlaying volume and compute 

parameters such as mean pixel intensity. Image statistics include an optional Threshold Slider 

that will remove pixels that fall outside of the selected upper and lower bounds. By using the 

threshold, a Pixel Positivity metric can be computed, which represents the number of pixels in 

the segmentation that fall above the threshold divided by the total number of pixels. 
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In the case of an “overlapping” dataset (where Primary and Secondary volumes are selected), 
the image statistics will be computed for each using the same segmentation object. 

You can save your work at any point by clicking on the Save button  located in the toolbar. 
To resume your work in another SonoEQ Analysis session, simply load in the volume(s), and 
the last saved state will be loaded depending on the elements present in the last saved session. 
Frequent saving is recommended when working with a large batch of volumes.  

5.4.5 Analyzing Data with Digital Calipers 

Digital calipers offer a quick solution to measuring linear distances in the 3D datasets captured 
by SonoEQ. Calipers can be placed in either Acquisition or Analysis mode.  

1) To start placing a caliper, click the Add Caliper button located in the top right corner of the 
SonoEQ interface 

 

 

2) The software will enter Caliper Placement Mode  and you can begin placing the start 
and end points of the caliper by clicking within a slice view or the 3D view where you would 
like to measure. The first click places one end of the caliper, and the second places the 
other. After the first click, a yellow ruler will appear with the distance of the caliper labeled 
based on where their mouse is currently hovering. After a second click, the second end 
point of the caliper is placed. Click the Add Caliper button again to place multiple calipers. 
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3) If you made a mistake and need to adjust the caliper, move the mouse over one of the 

crosshair endpoints and click-and-drag to adjust. The cursor will turn into a hand icon  to 
indicate the point is being edited when dragging. 

 
4) To delete an individual caliper, click the Delete Calipers button in the upper right corner of 

the SonoEQ interface. A message box will appear. 
 

 
 

5) Caliper visibility can be toggled on and off with the Show/Hide Caliper button located in the 
upper right corner of the SonoEQ interface. 

 

6) To quickly locate and view calipers placed in different positions within the scene, use the 
Select a Caliper drop-down menu, and the slices will update to the position of the selected 
caliper. 
 

 
 

 CAUTION:  

Volume measurements derived from calipers tend to be less accurate 
compared to volume estimates derived from 3D segmentations. This is 
because the equations that convert calipers measurements into a volume 
typically assume an underlying geometry (e.g. an ellipsoid) which may not 
accurately reflect the tissue of interest.  
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7) To save calipers to disk, click on the Save button located in the top left part of the interface. 
Upon loading the volume in a future SonoEQ session, any calipers that were saved will be 
automatically loaded with their corresponding volume. 

 

8) Lastly, to export caliper measurements to disk, click on File → Export Statistics from 
Scene → Caliper. A save file dialog will appear and allow you to save the caliper 
measurements as a CSV file. 

 

5.4.6 Analyzing B-Mode Sequences 

Segmenting B-mode sequences proceeds in much the same way as segmenting a static image. 

The primary difference is that segmentations are linked to a given frame in the movie sequence.  

The following describes the procedure for analyzing the volume of the left ventricle (LV) to 

assess functional metrics such as Ejection Fraction (EF) during cardiac imaging. 

1) Once in Analysis mode, the first step is to load one or more images for review. Clicking the 
Load Volume(s) button will bring up a file dialog that allows you to select either individual 
files or entire folders of data. 

 

2) Upon loading a sequence data set, the Slice Views window in SonoEQ will display the 
traditional four-up view showing axial, sagittal, coronal, and 3D views.  
 
 

3) (Optional) If the ultrasound planes do not match up with the long and short axis of the heart, 
the ortho-slices can be rotated and re-sliced for a better match. Press Ctrl + Alt + Left-
click-and-drag in any slice to rotate the intersections. This step is useful to better identify 
anatomical landmarks, such as the papillary muscles, and makes segmentation easier to 
perform. An image of a re-sliced volume is shown below. 
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4) Prior to segmenting the image, it is helpful to play the sequence movie and identify frames 
depicting peak systole and end diastole. This can be done with the Playback widget that is 
in the toolbar. Playing the movie is controlled via the Play/Pause button. Advancing the 
movie forward or backward can be done by clicking the Backward/Forward buttons. The 
current frame of the movie can be manipulated by adjusting the Playback Slider.  

 

5) Click the Add button to create a new “3D Segmentation Sequence” markup. 

 

A new row will appear in the Markup table, that includes two sub-rows corresponding to the 
four traces that need to be drawn to fully quantify cardiac parameters. 
 
The goal of the next several steps will be to define the boundaries of the epi- and 
endocardial surfaces that will be used to compute LV function.  
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The radio buttons to the left of each sub-row (1) allow you to select the appropriate cardiac 
surface (e.g. endocardial or epicardial). The drop-down menu on the right (2) indicates 
which frame in the movie sequence the segmentation is assigned to. Upon placing two 
segmentations in different movie frames, the software will automatically distinguish systolic 
and diastolic phases (3) by comparing the sizes of the regions.  
 
The following four segmentations needs to be completed for a full assessment of the LV:  

• Endocardial volume at peak systole (𝐿𝑉𝑉𝑠) 

• Endocardial volume at end diastole (𝐿𝑉𝑉𝑑) 

• Epicardial volume at peak systole (𝐸𝑝𝑖𝐿𝑉𝑉𝑠) 

• Epicardial volume at end diastole (𝐸𝑝𝑖𝐿𝑉𝑉𝑑) 

Ejection fraction (EF), stroke volume (SV), cardiac output (CO), and LV mass (LVM) can 
then be calculated using the following equations given a known heart rate (HR) and 
assumed cardiac tissue density of 1.05 mg/µL: 

𝐸𝐹 (%) =  (
𝐿𝑉𝑉𝑑 − 𝐿𝑉𝑉𝑠

𝐿𝑉𝑉𝑑
)  𝑥 100 

𝑆𝑉 =  𝐿𝑉𝑉𝑑 − 𝐿𝑉𝑉𝑠 

𝐶𝑂 =  𝑆𝑉 𝑥 𝐻𝑅 𝐿𝑉𝑀 =  1.05 𝑥 (𝐸𝑝𝑖𝐿𝑉𝑉𝑑 − 𝐿𝑉𝑉𝑑) 
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6) Using the Playback Slider, select the desired frame in the movie file (either peak systole or 
end diastole), and start by segmenting the endocardial border of the LV up to level of the 
mitral valve using any of the Segmentation Effects described previously. 

  

If desired, toggle the radio button, and segment the epicardial border of the LV at the same 
frame position. Epicardial segmentations are only necessary if LV mass is being quantified. 
The epicardial border is not required for functional outputs such as Ejection Fraction (EF) or 
Cardiac Output (CO). 
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7) Next, use the Playback Slider to select the opposite cardiac phase (in this case peak 

systole, as end diastole was segmented first above). Repeat the process of segmenting 
both the endocardial and epicardial borders, using the appropriate radio button selections. 
 

  

  

 

 
NOTE:  

Point placement mode can be turned off quickly by right-clicking, pressing 

spacebar or by clicking the Point Placement mode button . 

 



 

SonoEQ Version: 2.0.2 Revision:  22 

Title: SonoEQ User Guide 

Proprietary & Confidential   Effective Date:  11/22/2023 Page 64 of 108 

 

Copyright © 2023 Revvity, Inc. 

 

8) Once all segmentations are placed, green checkmarks will appear next to the Endocardial 
and Epicardial labels in the table, and a quick preview measurement (e.g. EF%) will be 
displayed in the Segment table. Quick toggling between systole and diastole can be 
achieved by selecting the corresponding measurement frame from the drop-down menu. 

 

 
9) To quantify all segmentations and export results to disk, click on the Quantify tab. LV 

volume in systole and diastole, ejection fraction (EF), stroke volume (SV), etc. will be 
computed automatically and displayed within the table. 

 
 

10) You can save your work at any point by clicking on the save button  located above the 
Slice Views. To resume your work in another SonoEQ Analysis session, simply load in the 
volume(s), and the last saved state will be loaded depending on the elements present in the 
last saved session.  
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5.4.7 Analyzing M-Mode Sequences 

Analyzing M-Mode data of the left ventricle (LV) involves segmenting/tracing the cardiac walls 

through the cardiac cycle. As with 3D Segmentations, this process is completed in the Image 

Analysis tab.  

1) Once in Analysis mode, the first step is to load one or more images for review. Clicking the 
Load Volume(s) button will bring up a file dialog that allows you to select either individual 
files or entire folders of data. 

 

2) Upon loading a data set, the Slice Views window in SonoEQ will display a dual view 
showing the M-Mode trace with a time scale bar below ad corresponding B-Mode sequence. 
The green triangle overlaid on the left side of the image represents the transducer focus at 
the time of acquisition and is displayed for reference. 

 

 

3) Prior to segmenting the image, it is helpful to quickly scroll through the M-Mode movie 
frames and select a measurement region not corrupted by breathing. This can be done with 
the Playback widget that is in the toolbar.  
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NOTE:  

B-Mode and M-Mode are both saved as “Sequence” files. When two 
sequences are loaded into SonoEQ, two Playback widgets will appear in the 
toolbar that control the B-Mode and M-Mode respectively. 

 

4) After selecting the appropriate frame in the M-Mode movie file, click the Add button to 
create a new “Cardiac Curve” markup. 

 

A new row will appear in the Markup table, that includes four sub-rows corresponding to the 
four traces that need to be drawn to fully quantify cardiac parameters. 
 
 

 
 

 
The goal of the next several steps will be to define the boundaries of the epi- and 
endocardial surfaces that will be used to compute LV function. The radio buttons to the left 
of each sub-row allow you to select the appropriate wall as follows, where anterior and 
posterior are defined relative to the ultrasound transducer. 
 
 

 
 

 
 
 

5) The software will bring up the Open Curve Draw module and automatically enter Point 

Placement mode . Begin by clicking on the M-Mode image to place control points. For 
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best results place at least one control point at each point in peak systole and peak diastole 
for at least 4-5 cycles (the more cycles drawn, the more accurate the final measurement).  
 

 
 

6) If you made a mistake and need to adjust a point, simply toggle the Point Placement mode 
off and click-and-drag points to adjust them.  
 

 
NOTE:  

Point placement mode can be turned off quickly by right-clicking, pressing 

spacebar or by clicking the Point Placement mode button . 

 

7) To Delete a point placement, utilize the trash can button  to delete the most recently 
placed point.  Note that deleting all points will result in clearing the edits made to the curve. 

 
8) After all points have been placed, click the Apply button or press the “a” key to accept the 

line. The software will automatically step to the next cardiac curve and enter the Point 
Placement mode. 

 

Continue until all four curves have been drawn to compute all cardiac parameters. After 
completing the two endocardial curves, the software will automatically detect peak systole 
and peak diastole and indicate the selections by showing red and green dotted vertical lines. 

 

 

 
NOTE:  

If only interested in calculating cardiac output parameters (e.g. ejection 
fraction, fractional shortening), just the endocardial borders need to be 
segmented. The epicardial borders are only used in calculating LV mass. 
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9) To quantify the segmentations and export results to disk, click on the Quantify tab within the 
Control Panel. LV inner diameter (LVID), wall thicknesses (LVPW, LVAW), ejection fraction 
(EF), etc. will be computed automatically and displayed within the table. 

 

 
The “Cardiac Calculations” are computed from the M-Mode measurements using the classic 
Teichholz equations that assume an ellipsoidal geometry for the left ventricle (LV) [1]: 
 
 

𝐿𝑉𝑉𝑠 =
7 𝐿𝑉𝐼𝐷𝑠3

(2.4 + 𝐿𝑉𝐼𝐷𝑠)
, 𝐿𝑉𝑉𝑑 =  

7 𝐿𝑉𝐼𝐷𝑑3

(2.4 + 𝐿𝑉𝐼𝐷𝑑)
, 

 

𝐸𝐹 (%) =  (
𝐿𝑉𝑉𝑑 − 𝐿𝑉𝑉𝑠

𝐿𝑉𝑉𝑑
)  𝑥 100, 𝐹𝑆 (%) =  (

𝐿𝑉𝐼𝐷𝑑 − 𝐿𝑉𝐼𝐷𝑠

𝐿𝑉𝐼𝐷𝑑
)  𝑥 100 

 
𝑆𝑉 =  𝐿𝑉𝑉𝑑 − 𝐿𝑉𝑉𝑠, 𝐶𝑂 =  𝑆𝑉 𝑥 𝐻𝑅   

 

𝐿𝑉𝑀 =  1.05 𝑥 [(𝐿𝑉𝐼𝐷𝑑 + 𝐿𝑉𝑃𝑊𝑑 + 𝐿𝑉𝐴𝑊𝑑)3 − (𝐿𝑉𝐼𝐷𝑑)3]  
 

𝑇𝑒𝑖𝑐ℎ𝑜𝑙𝑧 𝐶𝑜𝑟𝑟𝑒𝑐𝑡𝑖𝑜𝑛 𝐹𝑎𝑐𝑡𝑜𝑟 =  7/(2.4 + 𝐷)  
 
 
where LVV;s and LVV;d = LV end systolic/diastolic volume, LVID;s and LVID;d = LV end 
systolic/diastolic inner diameter, LVPW;s and LVPW;d = LV end systolic/diastolic proximal 
wall diameter, LVAW;s and LVAW;d = LV end systolic/diastolic anterior wall diameter, SV = 
stroke volume, CO = cardiac output, HR = heart rate, LVM = LV mass. A correction factor is 
also applied to the mass LV calculation (𝐿𝑉𝑀𝑐𝑜𝑟𝑟) where D equals length of the minor axis. 
 

[1] J. Stypmann, et al., “Echocardiographic assessment of global left ventricular function in 
mice.,” Lab. Anim., vol. 43, no. 2, pp. 127–37, Apr. 2009. 

10) You can save your work at any point by clicking on the save button  located above the 
Slice Views. To resume your work in another SonoEQ Analysis session, simply load in the 
volume(s), and the last saved state will be loaded depending on the elements present in the 
last saved session.  



 

SonoEQ Version: 2.0.2 Revision:  22 

Title: SonoEQ User Guide 

Proprietary & Confidential   Effective Date:  11/22/2023 Page 69 of 108 

 

Copyright © 2023 Revvity, Inc. 

 

5.4.8 AI-Assisted Automated M-Mode Analysis 

While cardiac wall segmentation can be done by hand, SonoEQ can automatically estimate 
placement of each trace in M-Mode images using artificial intelligence. 

1) Once in Analysis mode, click the Load Volume(s) button to bring up a file dialog that allows 
you to select either individual files or entire folders of data. 

 

2) Upon loading a data set, the Slice Views window in SonoEQ will display a dual view 
showing the M-Mode trace with a time scale bar below ad corresponding B-Mode sequence. 
The green triangle overlaid on the left side of the image represents the transducer focus at 
the time of acquisition and is displayed for reference. 

 

 
 

3) Prior to segmenting the image, use the Playback widget in the toolbar to scroll to the 
desired frame in the sequence. 
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4) After selecting the desired frame, click the Add (auto) button to generate the estimated 
cardiac wall traces. The segmentations will cover roughly the whole frame and the process 
will take a few seconds. 

 

 

5) The estimated traces will appear in the Markup table and on the image like manually 
segmented traces. As such, the same functionality that applies to manually segmented 
traces applies to the estimated traces; the Open Curve Draw module can be used to edit 
the estimated traces as described in the previous section “Analyzing M-Mode Sequences.” 

 

 

6) To include only a specific range in the frame for calculations, the Crop Model widget can be 
used to crop a section of the generated curves as a new markup. This can be useful for 
ignoring sections of breathing artifacts. The widget appears below the Markup table once 
both endocardial curves have been placed. 
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7) Click the Create ROI button to place a region of interest on the image. The ROI can be 

dragged and adjusted by clicking and dragging the points on the generated box. Once the 
ROI specifies the desired region, click the Apply ROI Crop button. This will generate a new 
markup group in the Markup table for the cropped curves. 

 

Full trace with Crop object overlaid 

 

Cropped M-Mode 
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5.4.9 Analyzing SWE Images 

Quantifying tissue stiffness can be accomplished by segmenting the SWE volume in the Create 
tab. The volume can be segmented manually using techniques described previously by pressing 
the Add button and using the Segmentation Effect Tools, or automatically by pressing the Add 
(auto) button, which selects the entire SWE volume. 

  

In addition to the SWE volume, SWE acquisitions compute a confidence map with the same 
dimensions, in which each pixel value represents the confidence in the shear wave velocity 
measurement at that location in the volume. The confidence floor can be adjusted in the 
Quantify tab to threshold any pixels with a confidence lower than the floor. 
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SWE stats are computed only on pixels not excluded by the confidence floor or volume 
threshold and can be found in the SWE statistics (Primary) table (above). The effect of adjusting 
the confidence floor on the volume can be seen here: 

 

SWE images and statistics can be represented in three different units; Shear Wave Velocity 
(m/s), Shear Modulus (kPa), and Youngs Modulus (kPa). You can select your preferred 
representation in Settings → Analysis → Quantification Settings → SWE Representation. 
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Each SWE representation has a default color scalar bar range. You can customize the SWE 
color scalar bar range in Settings → Analysis → Utilities and Display Options Settings → Default 
SWE Color Scalar Bar. 

 SWE Representation Default Color Scalar Bar Range 

 Shear Wave Velocity (m/s) 0.0 - 2.9 

 Shear Modulus (kPa) 0.0 - 8.3 

 Youngs Modulus (kPa) 0.0 - 25.0 

 

Default Range                                         Custom Range 

 

 
NOTE:  

Recall that the following equations are utilized by SonoEQ to convert shear 
wave velocity (cs) into either shear (G) or Young’s (E) modulus, assuming a 

tissue density (ρ) equal to 1 g/cm3 and a Poisson’s ratio (v) equal to 0.5:  

𝐺 =  𝜌𝑐𝑠
2   

𝐸 = 2𝐺(1 + 𝑣) 

𝐸 = 3𝐺 = 3𝜌𝑐𝑠
2 

. 
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5.4.10 Analysis of Secondary Volumes 

Whenever a 3D segmentation, a 3D sequence segmentation, or a SWE segmentation is added 
to a primary volume, Image Statistics are calculated for the secondary volume, if one is 
selected. For example, if a SWE volume is loaded, the corresponding 2D B-Mode will be 
automatically selected as the secondary volume and adding a markup to the primary volume will 
compute the SWE and image statistics for the primary and secondary volumes, respectively. 
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5.5 Additional Utilities 

5.5.1 M-Mode 360 

The following describes the workflow for the M-Mode 360 module, which allows drawing an 
arbitrarily placed M-Mode line (also known as “Anatomical M-Mode” in the literature) within a 3D 
cardiac sequence dataset.  

  

1) After loading a 3D sequence, click the Utilities tab to access the M-Mode 360 tool. 

 

 

2) (Optional) If the ultrasound planes do not match up with the long and short axis of the heart, 
the ortho-slices can be rotated for a better match. Press Ctrl + Alt + Left-click-and-drag in 
any slice to rotate the intersections. This step is usually recommended so that the M-Mode 
360 line can be placed in a single 2D view, rather than having to place it in the 3D view. 
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3) When satisfied with the 3D orientation of the heart, enter Point Placement mode  by 
clicking the respective button in the left panel. You can then click on any of the slice 
intersections to place the first control point and click a second time to place the second point 
that represents the desired M-Mode 360 line. After the first click, the M-Mode view will 
update dynamically with the mouse movement and the green line will be updated to indicate 
where the data is coming from. 
 

  
 

4) After completing the M-Mode line placement, either click the Save M-Mode or Save and 
Analyze M-Mode buttons. The Save M-Mode button will save the M-Mode to disk while the 
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Save and Analyze M-Mode button will save the M-Mode to disk and automatically launch 
the M-Mode analysis interface as described above. 
 

 

 
NOTE:  

The M-Mode image that is produced by M-Mode 360 is synthetically 
produced by repeating the single cycle data from the Phase Gated dataset to 
fill a standard 2 sec buffer. Phase gated 3D cardiac sequences represent one 
single heart cycle at a very high synthetic frame rate. The repetitions make 
segmenting the M-Mode easier with the Open Curve Tool. 

 

5.5.2 Volume Projection 

In scientific visualization, volume projection is a method to display 3D data in a 2D image. A 2D 
pixel is generated by performing a mathematical operation (e.g. mean, median, maximum) 
along parallel rays through the 3D volume traced from the viewpoint to the plane of projection. 
In SonoEQ, volume projection is particularly useful to create images that contain more 
information than just a simple slice through the data.  

 

Image of a maximum intensity projection in the coronal plane of acoustic angiography data 
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• Projection type – Controls the mathematical operation that dictates the projection. Default 
is maximum intensity. 

• Axis of Projection – Decide which Axis the projection should be done to. Default axis is 
Coronal. 

• Fit ROI to Volume Bounds – Resets the ROI to encompass the full volume. 

• Display ROI – Toggles the visibility of the ROI. 

• View Projection – Show/hide the projection. When the projection is shown, an ROI object 
appears in each slice. By using the ROI interaction handles, you can control the region 
being projected. The slice containing the axis of projection will be automatically updated 
when updating the ROI bounds.  

• Save Projection – Save a copy of the current projection image to disk. 

 

5.5.3 Data Probe 

The data probe utility displays information about the volume data at the location of the mouse 
pointer in the Slice views. Simply hover the mouse over any pixel in the slice views, and the 
data probe will update in real time.  

 

The Data probe shows several pieces of information: 

• The first line displays –  

• Color and name of the Slice view that the mouse pointer is currently over. 

• The patient-space location corresponding to the mouse pointer in 
Right/Anterior/Superior (RAS) space. 

• The orientation of the slice view. 

• The spacing between slices for the slice view. 

• The lower block of three lines displays –  

• L, F, or B for Label, Foreground, and Background, respectively. 

• The name of the volume (or None if nothing is selected). 

• The IJK coordinates corresponding to the mouse pointer. 

• The value of the volume at that coordinate (a single value for scalar volumes or the 
number or components for non-scalar volumes). 
 

5.6 Display Options 

SonoEQ offers several tools to help with visualization of 3D image data, including filters, 
colormaps, and volume rendering. These can be found under the Display Options tab when 
viewing files for analysis. 
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5.6.1 Color Scalar Bar Display 

 

• Enable Color Scalar Bar – enabling this checkbox adds scale bar for the current color map. 

• Color Scale Bar Volume Selection – drop-down allows in which volume to add the color 
scale bar.  

 

 

 

 

 

 

 

 

 

5.6.2 Volume Display 

The Volume Display (Primary) and Volume Display (Secondary) drop-down menus allow you to 
change how SonoEQ displays image data in the 2D slice views for the primary and secondary 
volumes, respectively. 
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• Lookup Table – Represents the underlying colormap used to display the data. B-Mode 

data is defaulted to use the Grey colormap, while acoustic angiography data is defaulted to 
use the Yellow colormap. Defaults can be changed in the Settings dialog.  

• Interpolate – When checked, slice views will display linearly interpolated slices through 
input volumes. Unchecked indicates nearest neighbor resampling. 

• Window/Level – When  the window/level settings for the active volume are locked 

and can’t be changed with either the min/max slider or the cursor tool . When  
window/level settings for the active volume can be changed. 

• Window/Level Controls – Double slider with text input to define the range of input volume 
data that should be mapped to the display grayscale. Auto window level tries to estimate 
the intensity range of the foreground image data. On mouse over, a popup slides down to 
add support for large dynamic range by giving control over the range of the window level 
double slider. 

• Threshold – Controls the range of the image that should be considered transparent when 
used in the foreground layer of the slice display. Same parameters also control 
transparency of slice models displayed in the 3D viewers. 

• Histogram – Shows the number of pixels (y axis) vs the image intensity (x axis) over a 
background of the current window/level and threshold mapping. 

 

 

5.6.3 Volume Rendering 

The Volume Rendering drop-down creates a 3D rendering of the image data. 3D renderings are 
shown in the 3D Viewport which has a blue accent.   

 
NOTE:  

Ultrasound data is saved as unsigned 8-bit integers with values ranging from 
0-255. These are unitless values referred to as “counts”. Scaling the min and 
max of the window/level control between these two values represents the full 
dynamic range of the images. 
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3D rendering of a B-Mode volume with a 
feature segmented in blue 

• Crop – Simple controls for the cropping box (ROI). More controls are available in the 
"Advanced..." section. Enable/Disable cropping of the volume with the checkbox. 

Show/Hide the cropping box using the Display ROI button . Reset the box ROI to the 

volume's bounds using the Fit to Volume button . 

• Rendering – Select a volume rendering method. A default method can be set in the 
application settings Volume Rendering panel. 

• VTK CPU Ray Casting: Available on all platforms, the volume rendering is entirely 
realized on the CPU.  

• VTK GPU Ray Casting: Available on all platforms with a dedicated graphics card, 
fastest method to volume render (default). 

• Techniques – Advanced properties of the current volume rendering method. 

  

• GPU Memory Size: Amount of memory to allocate on the GPU for volume rendering. 
By default, all the memory of the GPU is allocated. You can change the default 
behavior in the application settings Volume Rendering panel. 

• Quality – Not supported yet. 

• Interactive speed – Ensure the given frame per second (FPS) is enforced in the 
views during interaction. The higher the FPS, the lower the resolution of the volume 
rendering 

• Volume Properties – Advanced views of the transfer functions.  
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• Synchronize with Volumes module –  
     Click – Apply once the properties (window/level, threshold) of the Volumes 
module to the Volume Rendering module. 
     Toggled – By clicking on the checkbox, you can toggle the button. When toggled, 
any modification occurring in the Volumes module is instantaneously applied to the 
volume rendering. 

• Scalar Opacity Mapping – Opacity transfer function. Threshold mode: controls the 
transfer function using range sliders in addition to control points. 

• Scalar Color Mapping – Color transfer function. 

• Gradient Opacity – Gradient opacity transfer function. This controls the opacity 
according to how large a density gradient next to the voxel is. 

• Mapping controls – 

• Left button click – Set current point or create a new point if no point is under 
the mouse. 

• Left button move – Move the current or selected points if any. 

• Right button click – Select/unselect point. Selected points can be moved at 
once. 

• Right button move – Define an area to select points. 

• Middle button click – Delete point under the mouse cursor. 

• Right/Left arrow keys – Change of current point. 

• Delete key – Delete the point and set the next one as current. 

• Backspace key – Delete the point and set the previous one as current. 
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• ESC key – Unselect all points. 

• Interpolation – Linear or nearest neighbor interpolation. 

• Shade – Enable/Disable shading. Shading uses light and material properties. 

• Material – Material properties of the volume to compute shading effect. 

 

• ROI – More controls for the cropping box. 

  

• Display ROI – Show/Hide the bounds of the ROI box. 

• Interactive mode – Control whether the cropping box is instantaneously updated 
when dragging the sliders or only when the mouse button is released 
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5.6.4 Mean Filter 

The mean filter is a tool that can be used to reduce the speckle/graininess of the ultrasound 
image and improve contrast between organs. This mode works best when no additional speckle 
reduction techniques are applied (e.g. spatial compounding). 

 

 

• Radius – Controls the kernel size of the filter in units of mm. The larger the radius, the 
more smoothing and the blurrier the image will become. Kernel sizes between 0.2 mm and 
0.4 mm are ideal. 

• Apply – Executes the filtering operation. The time to compute the filtered image is 
proportional to the size of the underlying 3D volume and the chosen radius. The larger the 
data and radius, the longer the computation time. 

• View Filtered Volume – Show/hide the filtered volume. 
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5.7 Viewing Study Info 

The Info tab displays metadata saved with the image file that is being viewed. Metadata 
includes information you entered during image acquisition (e.g. study and animal information) 
and system parameters and settings (e.g. transducer type, focal depths, etc.). 

 

The displayed information can be filtered by the following subheadings. Multiple filters can be 
applied by clicking several subheadings (e.g. Study & Animal). 

• Study –entered info about the study including study name and timepoint. 

• Animal –entered info about the animal including strain, model, etc. 

• Transducer – Settings selected during image capture including transducer type, frequency, 
focal depths, compounding, etc. 

• Scan plan – Information about the scanned region. 

• Other – Software versions and other miscellaneous information. 

 

Certain metadata can also be edited from the table. Metadata Value fields with a white 
background can be double clicked to begin editing. Edited values will show a (*) by the attribute 
name indicating that it is unsaved. Edited values are not saved to the image file until the Save 
button is clicked and the scene is saved.  
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5.8 Analysis Settings 

Analysis settings and defaults can be accessed by clicking Edit → Settings from the top menu 
or opening the Settings Tray. Analysis settings are broken down into three subcategories 
including Markup Settings, Quantification Settings, and Image Processing settings. 

    

• Create Markup Settings – Settings related to the segmentation wizard (Create tab). 

• Root name – Sets the default name for new segmentations. SonoEQ will 
automatically append a numerical entry (1, 2, etc.) to the given root name when 
creating new segmentations. 

• Default colors – Sets the color pattern order for segmentations. Clicking one of the 
colored buttons allows for customization of the color. 

• 3D Segmentation Default Opacity – Sets the default transparency level for the 3D 
segmentation objects 

• Cardiac Curves Default Opacity – Sets the default transparency level for 
segmentation related to cardiac analysis (e.g. M-Mode curves) 

• Point Glyph Scale – Changes the size of the control points when placing new 
segmentations 

• Line Width – Changes the width of the line connecting the control points when 
placing a new segmentation 

• Link Opacity of Preview and Applied Markup – When checked, the opacity 
settings apply to both the 3D segmentation object, as well as the defined control 
points. When unchecked, only applies to 3D models and points are set to 100% 
opacity. 
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• Preferred 3D Segmentation Sequence Effect – Determines which segmentation 
effect is selected by default when creating a 3D sequence segmentation. 

• Preferred 3D Segmentation Effect – Determines which segmentation effect is 
selected by default when creating a 3D segmentation. 

• Preferred 2D Segmentation Effect – Determines which segmentation effect is 
selected by default when creating a 2D segmentation. 

• Preferred SWE Segmentation Effect – Determines which segmentation effect is 
selected by default when creating a SWE segmentation. 

 

  
• Quantification Settings – Settings related to the quantification table (Quantify tab). 

• Shown in 3D Segmentation Table – Determines which quantification value is 
previewed in the Create table for 3D segmentations. 

• Shown in 2D Segmentation Table – Determines which quantification value is 
previewed in the Create table for 2D segmentations. 

• Shown in Cardiac Curves Table – Determines which quantification value is 
previewed in the Create table for cardiac M-Mode segmentations. 

• Shown in 3D Segmentation Sequence Table – Determines which quantification 
value is previewed in the Create table for cardiac 4D segmentations. 

• Shown in SWE Segmentation Table - Determines which quantification value is 
previewed in the Create table for SWE Segmentations. 

• SWE Representation – Sets which representation to display for SWE statistics: 
Shear Wave Velocity (m/s), Shear Modulus (kPa), or Young’s Modulus (kPa). 

• Default SWE Confidence Floor – Default value for the confidence floor used to 
threshold SWE acquisitions upon load of SWE volumes. 
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• Utilities and Display Options Settings – Settings related to the image processing tools 
and display. 

• Default Volume Projection – Sets the default mathematical operation that will be 
used for volume projections. 

• Show Mean Filter on Display (3D Static Only) – When checked, automatically 
computes and activates the mean filter on loaded datasets. 

• Default Mean Filter Radius – Sets the default radius of the mean filter. 

• Default AA Colormap – Sets the default colormap for AA data. 

• Default SWE Color Scalar Bar – Sets the default SWE color scalar bar maximum 
and minimum values or (when checked) auto-scale maximum and minimum values 
for the selected SWE representation. 

• Default Volume Renderer – Sets the default option for 3D volume rendering. 

• Default Rendering Technique – Sets the default 3D rendering technique. 

• Auto-scale Color Scalar Bar Range for SWE – Sets whether the display range for 
SWE captures is automatically calculated or if the same set range is used for all 
SWE acquisitions. 

• Display Volume Info on Screenshots – When checked, volume information and 
metadata will be copied into screenshots and written into the output PNG file. 

• Display Markup Statistics on Screenshots – When checked, markup statistics will 
be copied into screenshots and written into the output PNG file. 
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6 Exporting Data 

The following section describes different ways for exporting image data as well statistics 
produced in analysis. 

6.1 Export Statistics 

Exporting statistics creates spreadsheet files which include data from multiple markups. Each 
spreadsheet is for a different markup type (e.g. one for 3D segmentations, one for SWE 
segmentations). A spreadsheet can include markups from multiple volumes. The statistics for 
the spreadsheets can either be pulled from the scene, or from statistics saved to file. Statistics 
in the scene exist in Quantify tables for loaded volumes, and in caliper lengths. Statistics saved 
to file exist in markup folders, with the name “stats.csv”. 

6.1.1 Export Statistics from Scene 

Statistics can be exported from the scene in two main ways: 

1) Clicking the Export All Statistics button at the bottom of the Quantify tab will export statistics 
for all loaded volumes that have markups or calipers, not only the primary and secondary 
volumes. 

 

Clicking the Export All Statistics button will prompt a save file dialog where you can select where 
to save the data. Three comma-separated value (CSV) files will be saved: 
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• segmentation_stats_YYYY_MM_HH_MM_SS.csv - 3D segmentation stats. 

• caliper_stats_YYYY_MM_HH_MM_SS.csv - caliper stats. 

• cardiac_stats_YYYY_MM_HH_MM_SS.csv - M-Mode cardiac curves and 3D 
segmentation sequences. 

• swe_stats_YYYY_MM_HH_MM_SS.csv – Shear Wave Elastography Statistics from 
SWE segmentations 
 

2) In the File menu on the top toolbar, you can select to export all statistics from the Export 
Statistics from Scene Menu (same as clicking the Export All Statistics button) or individual 
types: 
 

  

6.1.2 Export Statistics from Folder 

Exporting statistics from saved files can be done in the following way: 

1) Click File → Export Statistics from Folder 

 

 

2) A data dialog will popup that behaves the same way as the Load Dialog; using Select 
Folder and Select File(s) will add statistic files (“stat.csv” files) to the dialog, which can be 
filtered. 
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3) Click the drop-down list next to “Select Statistic Type:” to specify what type of statistics you 
wish to export. Only files visible in the table will be included in the export. You can also 
uncheck specific statistic files you want to exclude from the export. When ready click the 
Export button in the lower right of the dialog. 

 

  



 

SonoEQ Version: 2.0.2 Revision:  22 

Title: SonoEQ User Guide 

Proprietary & Confidential   Effective Date:  11/22/2023 Page 93 of 108 

 

Copyright © 2023 Revvity, Inc. 

 

6.2 Exporting Image Data 

Image data can be exported to a new location inside SonoEQ. Clicking Export Data in the File 
menu on the top tool bar will bring up a window where specific data can be selected for export: 

  

Data from any subfolder can be chosen and the file structure will be maintained when exporting 
so it can be loaded into SonoEQ. Checking the Include Raw Files in Export setting will include 
raw files used for reconstructing the final volumes. Checking the Send to Compressed 
(zipped) folder will export the data to a zip folder. 

 

  

 
NOTE:  

Some of the .MHD files will be exported even if the Include Raw Files in 
Export option is not selected because they contain import information about 
the volumes. 
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6.3 Study Report Generator 

SonoEQ can generate a PDF report of a study which tracks a markup statistic over time. To 
generate a report: 

1) In the file menu, click File → Create Study Report. 
 

  
 

2) A Study Report Generator window will pop up. In the Study Name Folder field click the (…) 
button and select a study folder. This folder’s name will be the same as the Study Name 
field in acquisition. 

  

 

3) The box labeled “Plot selected segmentations over time:” will become filled with every 
markup name that exists for the selected Imaging Type and Dimensionality. 
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4) Click the (…) button for the “Create Report In” text box and choose where you want the PDF 
file to be saved.  

 
 

5) Select the desired Imaging Type from the drop-down menu. Then select the desired 
Dimensionality from the drop-down menu. Then select the desired Statistic to be in the 
report. 
 

6) Now select which markups you want to be in the report by clicking the checkboxes in the 
“Plot selected segmentations over time:” table. 

 

7) Click the Generate button and your PDF report will be generated in the selected Create 
Report In folder. Each page of the PDF will show an image of the markup, a plot of the 
selected statistic over time, and a list of details about the scan and markup on that page. 
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7 Tools 

The tools menu has several options which will be explained here.  

 

7.1 Data Processing 

The first 3 menu items include tools for reprocessing data, which work in a similar manner as 
the Load Dialog; a dialog is populated using Select Folder and Select File(s), the files to re-
process can be fine-tuned by filtering, and checking/unchecking entries in the table and clicking 
Run will reprocess the files selected on the dialog. These tools can be used to process volumes 
for the first time (if Post-Scan setting “Fuse Options” is set to “Fuse Later” and you choose not 
to process data upon closing SonoEQ) or reprocess data with updated algorithms. 

Volume Reconstructor – reconstructs 3D acquisitions from raw files using calibration files 
saved on system. 

 

• Threshold for Breathing Motion – remove frames corrupted by breathing. Can be set 
to “Off”, “Low”, “Medium”, “High”. The threshold for the algorithm defines how 
aggressively to remove artifacts with “High” being the most aggressive, which might 
result in removing data without breath artifacts. 
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Run Phase Gating – phase corrects cardiac 2D or 3D B-Mode sequences. Parameters can be 
changed individually for each entry on the table or the values of entry currently selected can be 
applied to all entries by clicking Apply to all files. 

 

• Cardiac Motion Freq Range (BPM) – Range of heart rates to be analyzed in beats per 
minute. 

• Auto Hodrick-Prescott Filter Smoothing – Automatically calculate Hodrick-Prescott 
filter smoothing value. 

• Hodrick-Prescott Filter Smoothing – Coefficient for separating breaths from cardiac 
motion. Higher values generally work for slower heart rates, or Frame Rate Factor less 
than 2. This parameter is used only if Auto Hodrick-Prescott Filter Smoothing is not 
checked. 

• Axial Downsample Factor – Amount of spatial downsampling of original data for 
making single cardiac cycle sequence. A lower value may result on better image quality 
but will increase the processing time. 

• Axial Downsample Factor Phase – Amount of spatial downsampling for separating 
breaths from cardiac motion. A lower value may result in better separation but will 
increase processing time. 

• Frame Rate Factor – amount of temporal downsampling of original sequence. Lower 

value may result in better separation of breaths from cardiac motion but will increase 

processing time.  
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Run SWE Processing – runs SWE processing on 2D or 3D SWE raw data. 

 

• Push Offset (mm) – Distance between push and tracking region. 

• Push From Side – Determines on which side the push is in relation to the tracking 
region. 

“Push Offset (mm)” and “Push from side” are enabled for volumes collected using a version 
of SonoEQ older than v1.12.0 and can be set the values of the current entry for all entries by 
clicking Apply to all files. 
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7.2 Volume Compressor 

Clicking Volume Compressor opens a dialog that can be populated using Select Folder and 
Select File(s) buttons, like for the Load Dialog and data processing dialogs, for compressing 
and uncompressing raw image data to save disk space. 
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8 Instrument  

The Instrument menu has several options which will be explained here.  

 

Vega without a heater 

 

Vega with a heater 

 

8.1 Servicing Dashboard 

The Servicing Dashboard is used to service Vega systems and is available only to Revvity 
technicians. 
 

8.2 Heat Imaging Bays 

On Vega instruments configured with the internal heater module, an option will be present to 
Heat Imaging Bays. Clicking this menu option will turn the heater ON or OFF.  

 
CAUTION:  

Turning the heater OFF when an animal is sedated on the Vega can lead 
to hypothermia and harm the animal. Use caution when turning the heater 
OFF and ensure animal homeostasis is maintained via other methods.  

 

8.3 Initialize Motion Stage 

Selecting this menu option will start the motor system initialization homing procedure. It is only 

available when Image Acquisition connections have been successfully established and can be 

used if manual re-homing of the instrument is desired. 

 

8.4 Firmware Updater 

This feature allows updating or reverting the firmware of the wobbler engine, linear array engine, 
and heater controller.  

 
NOTE:  

If your “Observed Firmware” is the latest available, and you would like to 
revert back to a previous version of SonoEQ (e.g. pre-v1.13) you will need to 
revert back to the older firmware before SonoEQ can be used. 
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Firmware outdated 

   

Firmware current 

 

• Check – Clicking this button will update the corresponding icon to report the status of 
the firmware. Hovering over this icon after checking will display a tooltip with information 
about the current firmware. 

• Observed Firmware – Found by hovering over the status icon after clicking the “check” 
button. This is the version of the firmware currently installed on the system. 

• Latest Available Firmware – Found by hovering over the status icon of the linear array 
engine after clicking the “check” button. This is the most up to date version of the 
firmware. If the “Latest Available” and “Current Flashed” do not match, updating may be 
required to image with your system.  

• Revert to pre-1.13.0 Version – Clicking this button allows you to roll back the firmware 
version and install the compatible firmware for versions of SonoEQ prior to 1.13.0. 

• Update to latest available – Clicking this button initiates the wizard that will guide you 
through the firmware upgrade process. 
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8.4.1 To revert firmware for use with pre-1.13 SonoEQ: 

1. Open SonoEQ 1.13+ (only SonoEQ 1.13+ has the Firmware Updater) 

2. Click Instrument → Firmware Updater 

3. Click “Revert to pre-1.13.0 version” 

4. When prompted, turn off the Vega for 30 seconds, then turn in back on 

5. Re-open the Firmware Updater and check that the “Observed Firmware” has an earlier 

date than the “Latest Available Version” 

6. Close SonoEQ 1.13+ and install the pre-1.13 SonoEQ version you would like to use. 
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9 Data Storage 

Unless otherwise specified, all data captured with SonoEQ is stored under:  

%UserProfile%\Documents\SonoEQ 

We recommend regular backups of the data files to ensure the best user experience when 
running SonoEQ. 

If available, it is also recommended to backup data to a network-attached storage (NAS) server 
or cloud-based storage. 

File Format Reference 

This list defines the various file formats that are produced by SonoEQ.  

Extension Description 

.mha Binary file with reconstructed 3D image data 

.raw Binary file with raw, non-reconstructed 3D image data 

.mhd Metaheader data file associated with a .raw file, necessary for reconstruction 

.seq.* 
Metaheader data file of sequence data (i.e. CINE, 4D). The * represents either 
.mhd or .nrrd (e.g. “.seq.mhd”) 

.seg.nrrd 
Nearly-raw raster data (NRRD) file that contains 3D volume data used for a single 
3D segmentation 

.csv Comma-separated value file for exported statistics 

.txt Text file with saved study notes 

.png, .tif 
Image files for thumbnail projections of reconstructed 3D image data, and 
screenshots of camera view and ultrasound stream 

 

 

 

 
CAUTION:  

Be careful when moving or renaming the SonoEQ folder structure using 
Windows Explorer. SonoEQ relies on the folder structure to load 
associated files (i.e. a segmentation that was done on a specific image 
volume), and changes to this folder structure may result in unexpected 
outcomes.  
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10 Mouse and Keyboard Shortcuts 

Below is basic information about how to use the three-button mouse on Windows to perform 
operations in SonoEQ. If a specific View is indicated in the table below, the corresponding view 
must be clicked on first before the keyboard shortcut will function. 

Mouse Operations 

Action View Mouse sequence 

Rotate 
3D-only 

 
Slice-only 

Left-Click & drag 

OR 

Ctrl + Left-Click & drag (Rotate in-plane) 

Zoom All views Right-Click & vertical drag 

Pan All views 

Middle-Click & drag 

OR 

Shift + Left-Click & drag 

Brightness/ 
Contrast 

All views 

Press Alt + “c” to enter adjustment mode then Left-Click & drag 

• Adjust the brightness by moving the mouse vertically 

• Adjust the contrast by moving the mouse horizontally 

Cross 
Reference 

Slice-only 
Hold “Shift” while moving the mouse in any Slice Viewer will cause 
other Slice Viewers to scroll to the same position 

Maximize 
View 

All views 
Double Left-Click to maximize slice viewer. Double Left-Click 
again to minimize. 

Copy 
Image 

All views 
Right-Click on slice viewer and Left-Click on Copy Image to copy 
image to palette 

Expand 
ROI 

Slice-only Press Alt + Left-Click & drag ROI points to expand/contract ROI  
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Keyboard Operations 

Key View Effect 

r All views 
Fits the camera’s field of view to show all that is visible in the 
viewer 

v Slice-only Toggles the slice plane visibility in the 3D view 

h Slice-only Cycle through cardiac curves 

c All views Add Caliper 

Insert All views Create new markup 

Delete All views Delete selected markup 

   

   

 

Creating and Editing Segmentations 

Key View Effect 

a All views Apply segmentation 

e All views Edit segmentation 

g All views Toggle active segmentation visibility 

z All views Delete last control point placed 

Space Bar All views Toggle Placement mode 

Esc All views Cancel changes to segmentation 
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11 Troubleshooting 

In case of software crashes or unexpected behavior, you can access SonoEQ’s log files to 
share with the Customer Support team (http://www.revvity.com/contact-us) by using the Report 
a bug feature, which can be accessed through Help on the top toolbar. 

 

 

The most recent logs can be viewed in the “Recent log files” section of the “Report bugs and 
request enhancements” window. The contents of a selected log are displayed in the “Log file 
content” section.  The Copy log to clipboard will allow you to copy and paste the log file when 
emailing Customer Support. The Open log file location will open a Windows explorer window 
at the location where the log files are saved so you can attach logs when emailing Customer 
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Support. The Open log in file editor opens the currently selected log in a text editor such as 
Notepad so you can save it in a location of their choice. 
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